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Tools

Black Arrow (V or Ctrl)
"Selection Tool" moves stuff around

Line Tool (N)

makes lines, good for color separation

PenTool(P)— ————— — — —
just like in lllustrator but more of a headache

Oval (O)
makes circles
Pencil (Y)
makes line art
Free Transform(Q)— - - —— — — — —
scale, rotate, skew, edit centers, the good stuff

Ink Bottle (S)

creates a line around a filf

Eyedropper() - - - — — — — — —
identifies color values on fills
(good for alpha levels, that's about it)

Hand (H or Spacebar)— - — — — — — — —

moves around workarea, instead of scrolling

Colors

4 .
.
"o

Cptions

n
5

Magnet

makes points snap

Smooth
smooths paths, adds/eliminates points to do so

The Functions of the Black Arrow

Select Mode k Bendy Mode
Click and drag to select Click and Drag to
_/ bend a path

between two points

Duplicate Mode
gP Hold Alt, Click and Drag
o copy selection

k

—————————— White Arrow (A)
"Subselection Tool" selects points along a path
Lasso (L)

Selects broken artwork by circling it

Rectangle (R)

makes all sorts of polygons

Brush (B)

makes fill art

Fill Transform (F)
adjusts gradients
Paint Bucket (K)
adds a fill between a set of lines

Eraser (E)

Erases broken art

Zoom (M, Z, or Spacebar + Ctrl)
Take a closer look at your stuff with this!
(to zoom out hold down Alt)

Stroke Color
palette of colors for lines

Fill Color

~ palette of colors for fills

~ By holding down the mouse button
and dragging it beyond the palette,
you are granted with an eyedropper
that allows you to select a color from
anywhere on your computer desktop
—————————— Straighten

straightens paths, adds/eliminates points to do so

Point Mode Move Mode
Click and Drag Click and Drag to
on a point to move artwork
move it



Timeline

Layer — — —
use these to keep
symbols separated.
The layer on top is
the closest to the

Fla Tab

Toggles between multiple

open flash files
1
|
|

/
/

Show/Hide Lock/Unlock

Allows you to

Outline
Allows you to lock .~ Allows you to view a

-~ M
hide layers layers - layer in line work

P
IR NIEN Untitled-1*

camera.
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)] @ |[4] el Bl Ll 23 [240fes [ 05
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= / [ , 4 P P I Elapsed Time
- Insert Layer Folder |
- ,’ y # / . : n’ggy |  Frame Rate
Add New Layer ; i / / | "~ | Showshow
Delete Layer / / | | [ slow your file is
Add Motion Guide / / . | playing
Layer / ! |
y | Have No ldea I | Current Frame
Honestly, | have / | | The frame number
never used this / | I that the cursor is on
/ | . .
Onion Skin | Edit Multiple Frames
Allows you to view | Allows you to select frames
frames before and | across the timeline.
Frame Numbers after the cursor . . .
g Onion Skin Outlines
e, o e % Allows you to view frames
/ —_—— e ———— before and after the cursor
Vil e g K i0 / i5 ,20 in outline form
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| I\ I Cursor
| | \ / marks the frame you are viewing
Blank Keyframe (F7) | i e
a frame with no artwork. | NS
Insert a blank keyframe to | Frames (F5)
delete artwork for the | Insert frames to create time
remainder of the timeline or | between two keyframes. To
until the next keyframe remove frames hold
| Shift+F5
Keyframe (F6)
Insert a Keyframe on the
layer whenever artwork is

to be repositioned. To
remove a keyframe hold

Shift+F6
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Keyframes, Frames, Blank Keyframe
(check diagram below)




Editing Multiple Frames 6

By clicking on the onion skin buttons allow you to view and manipulate multiple keyframes at once. Upon clicking any of the three buttons, two
markers will appear above the layers in the frame number section. These markers indicate which keyframes are being viewed at once. Simply
adjust these markers by clicking and dragging them or by using the Modify Onion Markers (MOM) drop-down menu which has default marker
settings that are somewhat helpful. The only setting | use in the MOM drop-down is the Onion All, which sets the markers on both ends of the
timeline which is very conveinient on lengthy scenes. If you do not want to select keyframes on some of the layers, you can either Hide or Lock
the layers by clicking on the dots under the Eye icon (Hide) or under the Lock icon (Lock) next to the layer name. This will prevent you from
selecting everything on the timeline.

41w E) 1 [2406s [00s 4] |

frame 3 frame 4 frame 5

Modify Onion Markers

/ click here to get to the drop-down

/" menu. 1 R
/ Always Show Markers | Always Show Markers |
G2 1 |240fps | 00s 4 ‘ ,
— J Anchor Onion Anchor Onion
Always Show Markers
Onion 2 Dnion 2
Anchor Onion . —
Orion Conins |
Onion 2 Orion All Onion All
Onion 5 - . .
: { Onion 2 { Onion 5
Onion All . this setting will place the marker 2 & this setting will
I frames before the cursor and 2 I I place the marker
Heleioje frames after the cursor. Sjejejajei000i0/00le 5 frames before
the cursor and 5
4 frames after the
Always Show Markers | cursor.
Anchor Onion Onion All
this setting will place the markers
Onion 2 at the beginning and the end of the
. the timeline.
Onion 5

- Always Show Markers and Anchor
{ } Onion don't really help me much, so |
- l won't bother to explain.
o




Symbols 7

Any object that moves has to be symbolized before animation. Symbols can nest many levels of animated sequences. This can be very helpfull
when setting up heads with full mouth and eye charts, or arms and legs with a series of frames animating from straight to bent poses. First, select
the object , then press F8 to Convert to Symbol. A window will pop up asking to name the symbol and to set other preferrences. Set the behavior
on "Graphic" and set the Registration to the square in the center, now click OK. Now each time a symbol is made, it will automatically have these
preferrences set. However you will still need to name the symbol.

Convert to Symbol I

Mame: | QK I
Behavior: ¢ Mavie clip Reqgistration: EEE Cancel
" Button
¢ Graphic
& Advanced

— — Selected Object (Raw Art)

Once symbolized, the object is no longer "broken” raw art. The object is
now surounded by a blue box and added to the fla library. In the center is
a white dot, this is the edit point, the most important part of a symbol.
Before any animation is started the edit point must be adjusted to the axis
of rotation or the joint (like an elbow or knee). If the edit point is not
adjusted it can lead to hours of frustration in the longrun. To adjust the
edit point, select the Free Transform Tool (Q), this will able you to move it
to the desired position. For any reason you need the edit point to return to
its natural position, simply double click on the little crosshairs on the
symbol while the Free Transform Tool is selected. To break a symbol
hold down Ctrl+B.

_EditPoint | ¥ Library - Untitled-1 =
One ikem in library

Symbolized Object

Name Kind |use Count &
Heal symbol 1 Graphic - _||:|
0




Right-Clicking Symbols

Right-clicking symbols come with a whole lot of goodies, let's have a look!

Cut
Copy
Paste

Select All
Deselect All

Free Transform

Arrange

Breaks a symbol into
raw art, also Ctrl+B

— — - Break Apart
Distribute to Layers

This featureisa — — — —
favorite among many

I

\

] -~
-~
- -~
-

N - BringtoFront  Ctrl+Shift+Up
Bring Forward

Send Backward

SendtoBack  Ctl+Shift+Down

/‘* Self Explainatory

Arrange
< When you have multiple symbols on one
-~ layer (which isn't good), you can use these
to organize them by moving them in front
or behind other symbols.

-

because it wasn't E dlt

available on earlier .
editions of Flash. Edit in Place
sl i Edit in New Window

multiple symbols all on
ane layer and you

want them each on a , Swap Symbol...
separate layer, simply 7 .
hit this function and it Duphcate S}' mbol...

will do just thatlike ~ 7 - Convert to Symbal...

ial ;s 7 -
magic! // - : '
227 Timeline Effects »
;/ - *
g Y
™
Swap Symbol... N
Allows you to swap a symbol with another and it will keep any N N

transformation from the previous symbol, it's pretty neat!

Duplicate Symbol...

Use this if you want to change the artwork in a symbol but do not want to

mess up any other animation that uses the same symbol. It makes the old

symbol into a new symbol and maintains any previous transformation.

Convert to Symbol...

Same as F8

Lock
Uriock All

Ctrl+Alt+L
Bigkea(ees]ijes

not as usefull as Edit in Place

Edit in Place

by clicking this you will go inside the symbol one
level deeper for any editing. While inside you will
be able to see the mainstage in muted colors
outside of your symbol. You can also Editin
Place by double-clicking a symbol.

Edit in New Window

Much like Edit in Place except it will open the symbol in a
new flash file. You won't get that muted mainstage as in
the Edit in Place, therefore it is also not as usefull.

Timeline Effects

If you ever want to make something really
cheap looking use these, they are pretty good
for a laugh, that's about it.



Motion Tweens o

Now that your object is symbolized you can keyframe A & B positions on the mainstage.

i v Timeline

&390 ) 10 15 20 25 30 35

L b bt b a b b 4 b 4 b b A b 4 B b A & 4 B b 4 & 4 B b A |
(=

4% @ || 4] el 2 1 [2e0fs [00s <

Pose A Pose B
Frame 1 Frame 5

On Frame 1 we have Pose Aand on Frame 5 Pose B. To make the symbol to travel from A to B select a frame between the two keyframes, go to
the Properties Panel at the bottom of the screen and where it says "Tween" click on "None" and select "Motion". Now the frames, between the two
keyframes, will be blue and have an arrow pointing through them. This means there is a Motion Tween and the two poses have been automatically
inbetweened. Motion Tweens only work on symbolized objects on individual layers (one symbol for each layer).

i v Properties
Frame Tween; |Motion 2| scale
I =Frame Label> Ease: :
Label type: [Hame | rotate: Jase ][0 fines
[T Orienttopath [~ Sync [~ Snap

i w Timeline

aanI—'IIllsllllliolllrllslllllzolllllzslllléu:llllaéll

Aeskinlunluladudulmbabubulalmnbululalolnlmisdeslulnboladadadalalobebaimldel

& — |8

74541 d@ |4 alal Bl 2 [2406s [ 00s 4




Shape Tweens 10

Here is a Shape Tween, they can be quite tricky and can even corrupt files, so please be patient when using them.

TN @ |4 Blo w1 (2406 [00s 4] |

Pose A :
F 1 =
rame Pose B

Frame 5

On Frame 1 we have Pose Aand on Frame 5 Pose B. Note: these two shapes are not symbolized. To make the circle to morph into a square from
Ato B select a frame between the two keyframes, go to the Properties Panel at the bottom of the screen and where it says "Tween" click on "None”
and select "Shape". Now the frames, between the fwo keyframes, will be green and have an arrow pointing through them. This means there is a
Shape Tween and the two poses have been automatically inbetweened. Shape Tweens only work on raw artwork on individual layers. Most of the
time the two shapes will not morph right and you will have to add Shape Hints to help out the transition.

’ i Frame Tween:
s =Frame Label= Ease:
(= | |

| Label type: |Nﬂme 'I‘ Blend:

(oo B L[ 1 (2406 [0 4 |




Shape Hints 1"

Shape Hints are special little indicators that correct the transition of a faulty Shape Tween, which is too common. 26 Shape Hints can be used at a
time, marked alphabetically A-Z. To add a Shape Hint click on the first keyframe of the tween and go to Modify>Shape>Add Shape Hint.

Modify
Document... Chibnl

Corvert to Symbol., F8

e i) liifia:

Faulty Shape Tween I

When you first add a Shape Hint it might disappear. Don't be alarmed, it's just an annoying Flash bug. To see that Shape Hint again, simply go to
View>Show Shape Hints in the menu bar. With the Shape Hint "A’ in sight, directly in the center of the shape, click and drag it to a point on the
shape. Forthe best results, | start at the lower right-hand corner and work my way around in order counterclockwise.

After Shape Hinting the first pose, apply Shape Hints to the second pose. You must match the hints on the same points, otherwise the tween will
not work and | will make fun of you. When you go to the last pose of the Shape Tween, you should find all of the hints in the center of the shape.
The hints should also change colors from red to green once applied to the appropriate points on the second pose.

Corrected Shape Tween '

Bitmap » Pose A
Symibal »

Shape ) Smooth

) Straighten

Timeline » i .
Timeline Effects K Optimize... Ctrl+&t+Shift+C
F 5 Conwvert L_mes to Fills

P . Expand Fill..

5 Fill Edges...

Blign S| EE s
. . Shans Hint

E‘:“J“" e RemoveAl Hins




Document Settings 12

To edit the document settings: stage size, color, frames per seconds (fps); click anywhere on the mainstage for Document Setting options to appear
in the Properties panel.

This will change the color of your stage
|
|

This will change your stage size
|

This will change your frame rate

[ LA
This will change your export settings Useless information

Design Panels

Design panels are really helpfull to have open at all times when working in Flash. To open the necessary Design Panels go to Window=Design
Panels and bingo!

— — — — Hold Ctrl+L to open the symbol library

Deszsign Panels

The ones checked off are my favorites




Design Panels

Color Mixer
Use this panel to get colors.

H:rz-l;"—-j
S:lmj
B:lmj
Abha:lmj

WD

| #O066FF

v Align i= |

|

Align: |

B & & B o 5 |

Allgn = == === = = = = S Gl Al

Use these to line up symbols == P Ii___l > |

on the mainstage Match size: Space: |

S8 =dk__ | ____ |

__vfrmsfmn____________TF.':

) |

- o, o

TP e {*l100.0% % [100.0% [~ Constrain |

This panel will give the |
measurements of a symbol. (v Rotate <& I 0.0° [ =

You can adjust the scale & T — Q - 1

rotation of symbols by typing [ ' Skew I 0.0° i 0.0° - |

in numbers (for precise
adjustments).

Scene
In Flash you can make multiple stages
called Scenes. We don't use these when
we animate, we use these for character
model packs. One scene would be used
for the main turnaround, another scene for
hand charts, another for special poses etc.
Basically they are used for organization.

Library

This is the house where symbols live.
Flash allows you to organize your libraries
using folders. With a sufficient symbaol
naming convention, folders inside the
library are unneccessary, and often a
waste of time.

Symbol Properties

-
S~
S~

Create Folder — __

-

-

—

Create New Symbol — — — -

& R -

{“wLibrary - Untitled1~— — — — — _i_=,_|

One item in library |

|

|

|

|

|

|

Name | Kind |u 4|
(4] Symbol 1 Graphic |

o
/ FY
~
£ |
Fd
= |
-~
i |
-~
it |
"~ -
""_l:-._“l"'_._r —_— - _ﬁl
4 3
."J_ 1 @J__—__’ _______

Click here to switch from RGB to
HSB (Hue, Saturation, Brightness)

S

RGB
v HSB

Add Swatch

Help
Maximize Panel
Close Panel

stage as an axis.

This button is pretty lame, it just

- /copies symbols. Pointless once
you are familiar with the copy
and paste hot keys.

— _— _ This will return a symbol's

13

— — — This will align symbols using the

measurements back to 100%.

_~ Duplicate Scene

- Add Scene

— Delete Scene

Delete Symbol

use this button with caution if
you want to delete a symbol
from your stage because it's not

working with the animation, DO

NOT CLICK THIS! Select the
symbol you don't want on the
stage and press the delete key
otherwise everywhere that
symbol is throughout the scene

will be gone FOREVER!



History Panel 14

To make Commands, which are very similar to Actions in Adobe software, the History Panel is where it's at! You can basically make Flash
remember functions or steps you like to perform and assign them to hotkeys. It's the only benefit of Flash Mx 2004, THE ONLY BENEFIT. To open
the History Panel go to Window>0Other Panels>History Panel. Now let's make a command.

Other Panels Accessibility Al+F2
v History Ctl+F10
Movie Explorer  Al+F3
Strings Ctr+F11
Common Libraries >

First you have to think of a function that you often perform that there isn't a hotkey for. One that | tend to program on every computer | touch is a
Motion Tween with a Ease set to 100 (this will make more sense in further lessons). To make this motion tween command, | go to my timeline
select a keyframe and in the Properties panel | set a Motion tween and then set the Ease at 100.

v Timeline -
Tween: IMOtiBI‘I :I p Scale
Ease: | 100 Out A
Selected Keyframe
Rotate: IALItO I 0 Himes
I~ Orienttopath " Sync [ Snap

Now in the History Panel at the very bottom there should be two Frame Properties listings. Select both Frame Properties and right-click. In the

right-click drop-down select Save As Command. Name the command and click OK. Now in the main menu under Commands you should be able
to find your custom command.

ii v History =
m Frame Property
P

B Frame Property

| Commands Control Window Hel
Command name: | Motion Tween 100 | OK I Hﬂnﬂgﬂ Saved Commands...

Get More Commands...
Cancel |




Customizing Hotkeys

15

Now that we have our command we can make it a hotkey to make things even more efficient. To make custom hotkeys go to Edit>Keyboard

Shortcuts.
| Edt View Insent Modify Test Commal
' UndoFrame Propetty  ChvZ
Fepeat Frame Property  Chrl+y’
(ot il
Copy Cirle
Paste in Center Ctrl+
Paste in Flace (Biri+Shit+
Paste Special...
Clear Backspace
[Str{=ly
[Ciri+s
A CirlsShiftss,
Find and Replace Ctrl+F
Find Next F3
»
[Ztr]+E
Edit i Elane
gt
Preferences... Crl+lJ
Customize Tools Panel...

Name your custom keyboard shortcuts, | tend to use my name for my settings. Click Ok.

In order to set your own hotkeys, you must click on the Duplicate Set button to
the right of where it says Current: Macromedia Standard.

Kepboard Shortcuts

Current |Macromedia Standard _vJ E@‘] a | o
Commands: IDrawing Meru Commands j
+ File =
+ Edit
# View
H Insert
+ Modify
* Text
H Commands
# Control
+ Window LI
Description:
Shortewts:  + _.|
Press key: | ~ange I
oK I Cancel |

Duplicate name: I Pringle

Lo |
Cancel |

In the Keyboard Shortcuts menu scroll down till you see the Commands. Click on the plus box to drop down the menu. Now select Motion Tween

100. Closer to the bottom where it says Shortcuts, click the plus box. In the text box

Current !Pringle _'J @!a!ﬁ!
Commands: IDrawing Menu Commands :J
¥ Text EI
= Commands

I Manage Saved Commands. ..
1 Get More Commands...

# Control
= wWindow
+ Help

<empty> should come up. In the Press Key box type your hotkey, | used Ctri+Tab.

Shortcuts: 4 | =

Prass key: ol Tatd

MNow click Change. Where it said <empty> in the Shortcuts text box, it should now
say the hotkey you typed in. Click Ok.

shortcuts: 4 | =
Chrk+Tab =
J -
Press key: | Ctri+Tab Change I

In the Commands on the main menu, you should now see your command and the
hotkey labled beside it.

Commands Control  Window Help
tanage Saved Commands...
Get More Commands...
Run Command...

Chl+T ab

Motion Tween 100

So there you have it, this is how you get Flash to automatically do work for you at the click of a button. Commands are very helpful and very
addictive, they are very simple to make and if you are a programmer, possibilities of what you can command Flash to do are nearly endless; the

only problem is finding a hotkey for each command you make!



Chapter 2
Flash Clean Up
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Importing

Cleaning up drawings in Flash is an important process for every animator to understand inside and out. Flash isn't the best program to clean up
drawings in, but to minimize work in the long term, it is beneficial to keep the majority of work in Flash.

This is the character | will be cleaning up. Since | am not the greatest draftsman, | decided to 'borrow' this design from Preston Blair's Cartoon

Animation Book.

The first step of cleaning up an image is to Import the file into flash.
Go to: —
File > Import > Import to Stage FETE Ukl
Or you can use the hot key Ctrl+R T, il
Dpen from Site...
Open Recent 3

Close Cilw
Close All

Save Chrl+5
Save and Compact

Save Az Crl+Shift+5
Save as Template. .

Save All

Rewvert

Imiport »

Export >
Publish Settings...  ChlShift+F12

||'|":r[ I_|:- Stage..
Import to Libray. .

Open Extemal Library...  Chil+Shift+0

Publish Preview 3
Publish Shift+F£12

Page Setup...
Pririt... Cirl+P

Send...

Edit Sites...
Exit CuleQ

Constructing

"When constructing an animated character, visualize it as a three dimensional puppet
that you are joining together with solid masses.”
- Preston Blair

When cleaning up a character, study the design a bit and try to imagine how it would
move if it were a paper doll. Think of each body part individually, even the ones that
aren't visible like the arms and legs that are away from the camera.

17



Inking 18

The very first thing to do is to have your image on the bottom most layer. Then lock the layer so that the art doesn't move around when you are in
cleaning mode. Now make a new layer above the art layer and get started applying the outlines using the Line Tool or the Pencil Tool. It is best to
clean each body part on its own layer and draw through each part.

© w Timeline
1

-
Qtaverz .

So here in the image below, | have a layer named "body" and that's where | began to ink the body. | drew the bean shaped body all the way through
without any breaks in the line. There are some elements on the body like the shirt ruffles and the collar, to make it easier on myself | am going to
ink those on a new layer above the "body" layer.

L=
Jm 0O

M=

© ¥ Timeline

490

L) art « 90

Now on the layers "collar”" and "ruffles,” | inked the collar and ruffles. | hid the body layer so it wouldn't interfere with inking the rest of the shirt
elements.

i % Timeline

P ruffles
[/ body X 9
[ art . @

O
[/ collar e + []
[
O




More Inking 19

| turned the collar and ruffles layer off the body layer back on so | could finish the rest of the details. Notice that under the ruffles | inked a line
across the body, this is to separate the color of the shirt and the fur. Don't worry though, this color separation will be covered by the ruffles , no one
will ever know!

©w Timeline

[/ collar
L/ ruffles
tn:ld';."
[/ art

To ink the back arm, | hid all of the layers except the art layer. | made a new layer "arm back." Since the arm will be behind the body, its layer has
to be under the body layer. Even though | could not see the whole drawing of the back arm because of the front arm and the body, | still drew it all
the way through as if the character was not two dimensional. This will give me a lot more flexibility out of the drawing, if | had not inked the arm all
the way through, there would really be no way to get appealing animation out of the pose. | also rounded off the end of the arm for better rotation,
and | attached the glove cuff to the wrist but left the hand separated to allow more hand poses.

© ¥ Timeline

1 =3
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XXX ¥
ogogmeooOon

[/ collar
[/ ruffles
[/ body

(2 art . @

-~ ¥ Timeline

P
./ body X .
./ arm back K .

¥ hand bac f »
[ art o g

| now inked the back hand. |inked it on a new layer
and | drew it all the way through under the cuff. Some
of the detail looks pretty bad, but it will look better once
| adjust the line weights later on.

=)
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Inking With the Rectangle 20

My brother showed me a nice little clean up shortcut using the rectangle tool and some neat hotkeys to make the inking experience a breeze. First
select the Rectangle tool (R) and click and drag a box on a new layer over the drawing. Without selecting the Black Arrow Tool you can still achieve
its functions by holding down the Cirl key. With that said, hold Ctrl and move the mouse over the corner of the rectangle you've made and click and
drag the points over the line of the drawing.

i w Timeline Ve

1]
@0

Four points are not nearly enough needed to clean up this drawing. Usually what | would do to make more points is to select the Line Tool (N) and
intersect the line to make more points. This is not necessary if holding Ctri+Alt, which allows you to make new points on the line by clicking and
dragging, it makes clean up so fast! Now by holding down Ctri+Alt | will click and drag points into all of the corners of this hand.

With all of the points needed, | can start curving out the outline. To do this, | will only hold the Ctrl key and click and drag the line between two
points and bend the line matching the drawing.

Now that the hand is silhouetted, | will select the Line Tool (N) and add any extra detail on the inside and I'll be done.
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I'm too lazy to type a description for every body part | ink, like anybody is even reading this! So the next couple of pages will be a collection of my
progress. Please pay notice to how every body element is inked all the way through.

=0}
[J ruffles X+ 0O _ [ nuffles x
[ body X0 L/ body X
W oupperlegfront X+ [

i w Timeline - \ i w Timeline
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[/ arm back

X
[/ hand back x
[ art .

i w Timeline . \ i w Timeline
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[ upper leg back X0
[/ lower leg back X1
B foot back .
[ arm back X0
[/ hand back X+ 0

i w Timeline
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More Inking

i w Timeline
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[ ruffles X3
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Paint

Here's the result of the ink process. | know what you are thinking, and you're right- it looks awful! Fear not, if | paint bucket all of the parts with
white it will begin to look better. To make the clean up go faster you can add color as you apply the lines. | saved the color for last purely for

educational purposes.

After painted white

Lines

Now that all of the parts are filled in with white, to make it look even
better | am going to go through and delete some lines | don't need
anymore and alter the line weights using the stroke options in the
properties panel. To change the stroke of a line, select the line and then
adjust the thickness in the Properties panel either by typing in a number
or by dragging the level thingy.

- ¥ Properties

Shape s B |3 r If-‘Jlid _‘ﬂ Custom...

wel 147 w4339

H:|119.2 y:| 187.8
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All done. The problem with flash is that the lines do not have a taper option and they all have rounded ends. To get a flat end and tapered

strokes, Flash gives the option of converting lines to fills. Modify > Shape > Convert Lines To Fills. Once converted, you would have to modify
each line manually, which can be a lot more work, but it gives the design more appeal at your control. If the conversion of lines doesn't sound like
your cup of tea, there are always the brush features in Adobe lllustrator which are very awesome. With the brushes in lllustrator, a line can have a
rough pencil texture or a smooth taper to a point at the click of a button. However, this is a flash course, if you wanna learn more about lllustrator,

you should take an lllustrator course.

rounded ends

Me needs eyebrows
and whiskers!

Lines Deleted _

— — Lines Deleted

Lines Deleted Line Weights Adjusted

| also changed the design a bit with the legs and the
front ear so they would work better in Flash. The
webbed legs do not work too well in Flash, | also
segmented them into thighs and calves so | won't need
new drawings to make them bend. The ear has a fold
over the head and then under the head, | decided to
just make the ear go completely behind the head.

Webbed crotch
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Symbals are the casing for broken or raw art. Raw art is only affected by editing it inside of a symbol. Each symbol contains its own independent
timeline from the one on the mainstage, which gives Flash a huge advantage as a software for animation. With somewhat limitless levels of
timelines constructing a single character, Flash provides animators the availability to make fluid animation full of secondary motion and subtle
movement that would not be as convenient to produce if traditionally done. Symbols are the basis of reuse in Flash animation. Once artwork is
symbolized, it is 'one drawing' throughout an entire scene. If the same artwork is not symbolized, but however is used to animated with throughout
a scene, each time that asset is keyframed, it is interpreted as a 'different drawing' every keyframe it appears, which often makes files difficult to edit
and also playback slower. Confusing? Basically, symbols let Flash know that a piece of artwork is reusable by storing it in the Library, and if it's not
symbolized, the art is not fully being reused. Sorry, | have no better way of explaining it, try reading the User Manual or something.

Any asset that is animated in Flash must be symbolized. Animating raw art is only acceptable when it is traditionally done, which is okay to do in
Flash, but then what is the point of using Flash as a tool if it isn't utilized to its full capacity? Symbols have the availability to be motion tweened
which eliminates the amount of inbetweening one must do to make animation beautiful. Symbols can be squashed, stretched, rotated, and skewed
but they cannot bend. To bend artwork, you must go inside a symbol by double clicking it. Once inside you can manually bend the art by pulling
points with the arrow tools or by using the envelope tool (which can be quite buggy). An even cooler way of bending art is by copying it and pasting
it into lllustrator, making the art a brush and applying that brush to a curve, then pasting the curve back into the symbol in Flash. It's such a
wonderful feature Flash lacks, it's the only feature lllustrator has that makes it a necessity when animating in Flash. Just be aware that sometimes
while copying artwork back into Flash from lllustrator, Flash will drop out points from the artwork sometimes causing it to disappear. If this happens,
try slightly rotating the artwork in lllustrator before copying, then after pasting it in Flash, if successfull, rotate it back to how it was.

To symbolize, select the object , then press F8 to Convert to Symbol. A window will pop up asking to name the symbol and to set other
preferences. Set the behavior on "Graphic” and set the Registration to the square in the center, now click OK. Now each time a symbol is made, it
will automatically have these preferences set. However you will still need to name the symbol.

Convert to Symbol Ed |

Name: OK I

Behavior: " Mavie clip Reqistration: ﬁgﬁ Cancel
" Button
&+ Graphic
HaEA) Advanced

Behaviors are the type of symbol being created. Movie Clip symbols allow animation to exist inside of a symbol but will only playback in a Flash
Movie file or SWF. Also animation will loop inside of a Movie Clip symbol unless if Actions programmed tell it otherwise. Movie Clips are not used
or not suppose to be used for television animation, they are primarily for website design/animation. Button symbols are also only for the web, they
are symbols that contain hyperlink capabilities and all of that interactive junk, useless for television. Graphic symbols contain art without the weird
internet hoopla, which is why they are used in television productions. | don't know what else to say about Graphic symbols. | set my symbol
Registration to the center for copying and pasting frame reasons. It won't make any sense if | try to explain, | just like it in the center, you should
too.

To select the raw art you can either = z =
select it by using the Black Arrow tool, i/ ¥ Timeline

which functions exactly like the

Marquee Tool in Photoshop when

clicking and dragging over the Select the
artwork, or by simply clicking on the n arm from keyframe
keyframe that contains the art you to select
want symbolized. With this said, let's L/ hand front ' srtork

get started symbolizing our character.

Convert to Symbol X | |

Name: | armp OK
Behavior: ™ Movie Registration:
- ~ ciip §§§ Cancel Give the symbol a name. Each production has a
Button different naming convention, don't stress too much
O raphic on what to name your symbols right now, save it for
Advanced when you are on an actual production.
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Once symbolized, the object is no longer "broken” raw art. The object is now surrounded by a blue box and added to the fla library. In the center is
a white dot, this is the edit point, the most important part of a symbol. Before any animation is started the edit point must be adjusted to the axis of
rotation or the joint (like a paper doll/puppet). If the edit point is not adjusted it will be difficult to animate the symbol throughout the scene. Also if
edit points are later adjusted mid-animation, most-likely, any motion tweens set will become buggy. Motion tweens use the placement of the edit
points to generate the inbetweens, if two edit points don't match up on the same symbol, the tween will not move properly. Therefore it is very
important you adjust edit points to a permanent position on the symbols before beginning animation. To adjust the edit point, select the Free
Transform Tool (Q), this will able you to move it to the desired position. For any reason you need the edit point to return to its natural position,
simply double click on the little crosshairs on the symbol while the Free Transform Tool is selected.

Default Edit Point

Adjusted Edit Point Cragshairs

)
[ 7 = "
|

Now I'm going to waste no time and go ahead and symbolize the rest of the rabbit, please bear with me.

Convert to Symbol - B H Convert to Symbol i —— L Convert to Symbal
Mame: IhandR MName: Imuzzle

W

Mame: | teeth

<

Convert to Symbol Convert to Symbol
hame: Icheeks Hame: lhair

i

Convert to Symbol .
Mame: |m0uth

:/N

i
\G i Mame: |head{

Convert to Symbol .
Name: [pupin _ Mame: [ eyer

Convert to Symbol i ~
|
.
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Please pay attention to where | am placing the edit points, otherwise there is no point of me taking a screen grab of each part | symbolize.
Thank you.

Convert to Symbol &

MName: | earR

Convert to Symbol Convert to Symbol Convert to Symbol
Name: [earLt hame: lcoltar Mame: |ruFFIes|

- Convert to Symbol
Hame: lneckl

T
Convert to Symbol
Mame: |body|

Convert to Symbol L
Mame: |uppertegR

Convert to Symbol

N
NS

Y Convert to Symbol
Convert to Symbol " . "

hame: l lowetlegr

‘h——ﬂ/

Name: |fontR N -

Name: | upperlegl

Convert to Symbol

Name: l handL

Convert to Symbol "
Mame: |I'owerlegl

Convert to Symbol —
hame: |fontL

-— Convert to Symbol -
Name: IarmL
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Symbols nesting other symbols are referred to as Comps. Comps nest concentrated animated sequences called Instances. This can be very
helpful when setting up heads with full mouth and eye charts, or arms and legs with a series of frames animating from straight to bent poses. Fla
set up depends highly on comps, the more comps in a fla, the more organized it will be. But be weary, it is possible to have too many comps where
it will weigh down a Fla and will make editing animation very difficult.

Now that | have the rabbit symbolized, | am going to make the necessary comps, follow me...
Select all of the face elements to make a head comp, including the head, ears, hair, etc... This is where the facial acting will be animated.
Press F8 to symbolize it all together

Make sure to add "comp” in the symbaol name so you know it's a comp
Adjust the edit point to where the neck connects to the head

Convert to Symbol
Mame: Iheadwmp|

N\

o

All of the layers on the timeline that once held the face elements are now blank keyframes, - " -

we can trash these layers to keep our file clean.

Double Click on the headcomp symbol to get inside

Click on the one keyframe inside to select all of the symbols

Right click any of the symbols on the stage and select Distribute to Layers

) &G04
Cut [/ Layer 1 « « 0O
Copy P muzzle /[ * @
Pasio [LJ teeth + + []
Select Al [ mouth s + W
Deselect All [LJ cheeks S - m
Free Transform W hair -8
Arange > g pupilR + -+ 0
eyeR - N
You can delete all of these layers to Layers I [ e ' B
Convert to Symboal... [ head e « [
Timeline Effects » [J earr « « [0
[J earl + + []

Now all of the symbols magically separated onto their own layers.
Even the layers are automatically named after each symbol.
Notice next to where it says "Scene 1" there is a Graphic Icon and it says "headcomp”, that means | am inside of the headcomp symbol, to get out
of this symbol double click any blank area on the stage or by clicking where it says "Scene 1",
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Now I'm going to make a mouth comp. This character has cheeks, a muzzle, and teeth that can be self-contained in a comp.

Select all of the mouth elements.

Symbolize them "mouthcomp”

No need to adjust the edit point it's fine where it is.
Delete any empty layers.

Go inside the mouthcomp and distribute to layers.

[/ muzzle « « @ Convert to Symbol

[J teeth « « 0

[ mouth . B Mame: | mouthcomp
' |

Sl = sceret B headionp B mouthcon |
i v Timeline
&80k 5w
P muzzle [ e
[/ teeth o o []
[/ mouth + + [
() cheeks e o [

Notice that the artwork that is not inside of the comp is grayed out, that
means you cannot select any of it unless if you exit the symbol you are
currently in.

Now let's put the body elements in a comp, | doubt the ruffles and collar Convert 1o Ga i
will be animated much so they can be joined with the body. This will L4

also minimize the amount of layers on the timeline.
Name: Ibodycornp
n .:Qnar j « + N . 1
[/ ruffles « « [
[ body .

— l = Scene1 A bodycomp
¢ v Timeline




More Comps

To finish, | am going to make a character comp. All of the rabbit's animation will be inside of this comp.
Select all of the rabbit's symbaols.

Symbolize F8.
Delete Empty Layers

Go inside of the comp and Distribute to Layers.

Save your work.

and now we are done with this lesson.

Convert to Symbol
Name: Irabtit

31

(=] | — Scene1 [ rabbit

i ¥ Timeline
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() bodycomp e+ []
[/ neck « +« [
L/ upperlegr « o @
[/ lowerlegR e o [0
[/ footr » o [l
[ tail + o @
L/ upperlegl e+ O
(/) lowerlegl » » B
[/ foatL e o []
L/ arml o @
[/ handL « [

¢ w Timeline
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P Rabbit ;e .
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Adjusted Edit Point

Now the rabbit Fla is nice and neatly
organized. The stage only has two layers,

the rabbit layer with the rabbit comp and the

art layer with the jpg of the rough drawing.
Notice | adjusted the edit point on the main
comp to the bottom of the symbol because

that is where all of the rabbit's weight is.
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Now that the character is built with symbols and comps, we can complete the model by adding an eye and mouth chart to make it animation-ready.
With eye and mouth charts, we will have the ability to make our character blink and talk by simply calling upon instances in the head comp rather
than drawing new eye and mouth poses every time face acting is needed.

To get started with the eyes, click into the eye symbaol.

= Scene1 [ rabbit EA headcomp A eyeR

Q)

Make a new layer above the existing layer, add a new frame (F5), and add a keyframe (FB) on frame 2 and draw a line to make the eyelid. Anew
layer for the eyelid line will allow you to tween the line as shown in later steps without difficulty from the software.

- 4 \ © ¥ Timeline
- @ O ,lﬂ __ — New layer & keyframe for the eyelid

Notice that | made the line go all the way across beyond the eyeline, this is because I'm going to make a new keyframe on frame 5 and position
that same line to the bottom of the eye and then add a Shape Tween between the two keyframes. | just pulled frame 5 out of the air, you can
make as many inbetweens for the blink poses you think would be necessary.

' '\ ¥ Timeline ¥ Timeline
901 5| &40

3
-ﬂﬂﬁlllllw-H-
ml Dml ..Du 0

Add keyframes to the entire shape tween so each eyelid position can be cut and pasted onto the same layer as the eye to flatten the artwork to
add color. First, select the whole shape tween by clicking on the first keyframe (it starts on frame 2) and dragging to the last (frame 5), you'll know
you're doing it right when the frames turn black (that means they are selected). Then after they are selected, convert to keyframes by clicking F6.

¥ Timeline ¢ ¥ Timeline . }
& 90 : |5 \
=LILIL]
[ Layer 1 + ¢ [T}, '
i
| | Inbetweens created
: ' by the shape tween
Selected Shape Tween Keyframed Shape Tween

Now on the bottom layer, add keyframes to all of the frames by selecting all of the frames on the layer and F-sixing them. This is so when the
eyelid poses are cut and pasted onto Layer 1 they will be pasted onto their very own keyframe along the timeline so they animate and not just sit
on the first keyframe. That would be bad.

i v Timeline

&aan0: §

Selected Frames Keyframed
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With all of the keyframes in place, now cut (Ctrl+X) and paste in place (Ctrl+Shift+V) each of the eyelid lines on the Layer 1 keyframes directly
below.

i Timeline This is what the
1 ' _ ' ! timeline should look
&40 5

, like after "flattening”
the eyelid lines with the

eye.

Dlafu'l = +« B (.0000

Go through all of the poses and delete the unnecessary lines that are on the outside of the eyelines. Since the eyelid lines now intersect with the
eye line, you should be able to simply select them by clicking with the black arrow, and simply delete them by clicking delete.

Unnecessary lines to delete
Deleted Lines

JQ

Trash the top layer since it is now a row of empty keyframes. Add another keyframe on frame 6 and draw a closed eye pose. What | did was just
remove the eyelid line to make the eye appear closed, | also filled in a shade of gray in the lid so the blink is more clear for you to see.

QU E

Frame 1 Frame 2 Frame 3 Frame 4 Frame 5 Frame 6

To set up the eye for the pupil to animate, the first thing to do is to make a new layer and move it below Layer 1 by clicking the layer where it says
the layer name and then drag it below Layer 1. Select the white in the eye from frame 1 and cut and paste it in place on the new layer, then go
through the rest of the eye poses and delete the whites. This is so the white of the eye is on its own layer below the lid.

"\
i ¥ Timeline i ¥ Timeline \l

& 900
(L) Layer 1 « [

I Layer3 / * + B

i b Lt |

L Layer 1
New layer added New layer moved below Layer 1 Eye white selected

i # Timeline

T e

Eye white pasted on its own layer
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Now that the lids are separated from the whites, we can exit the eye symbaol to the headcomp symbol. Make a new layer above the pupil layer.
Copy (Ctrl+C) and paste in place (Ctrl+Shift+V) the eye symbol onto the new layer. Right-click the eye symbol on the eye layer and select
Duplicate Symbol, name the symbol "eyeR white". This will allow the art inside the symbol to be changed without effecting the eye symbol we
spent so much time making the blink inside. Double-click on the eyeR white symbol to edit in place and delete the top layer containing the eyelid
animation. Don't worry, if you did this right all of that eyelid animation should still be in the regular eyeR symbol.

i w Timeline
FA rabbit  FA headcomp H— ]
saoj|
= = B (1) mouth |
- 1 5
tg D L T w hair - . .
[ mouth « « W
il - L o
L hai -1 -/ pupiR M This is what it should look
[ eyer « o [ like after pasting the symbol
[/ pupir « « [0 on the new layer
9 eveR .« + B eyeR symbol pasted on the new layer

New layer added above the pupil layer

\\ = Scene ! [ rabbit A headcomp [ eyeR white

& ¥ Timeline
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. Click the trash can
Symbal name: | eveR white oK
I l—II icon to delete the layer

Go back outside to the headcomp symbol and double-click on the eyeR symbol on the new layer to edit in place. Inside of the eyeR symbol select
and delete the bottom layer containing the white of the eye.

= Scene 1 [ rabbit KA headcomp A eyveR

Exit to the headcomp and tah-dah! To see what
you did select the eyeR symbol and go to the
¢ w Timeline properties panel, where it says "Instance of:" it
should say "eyeR". In the box next to "First," type
in the number 4, the forth frame inside of the eyeR
Q Layer 1 « o [ symbol will appear on the stage in the headcomp
. symbol. Most of us Flash geeks refer to this as
Delgtethis1ayeh == == = "calling upon an instance." So if you ever overhear
4 i us in our dork-talk mentioning the calling upon
instances you will know what we are referring to.
The eyelid now overlaps the pupil, giving the pupil the ability to freely to move around the inside of the eye. I'm going to go ahead and perform the
same steps on the other eye, there is no need for me to document it though, otherwise I'd be repeating myself and forcing you to read it.

i w Properties
|@ | Graphic ~]| Instance of:  TeyeR |
|~ =1
_Ef."';..l 'Loop 'Iilrsl:: |ﬂ_|

— w219 xf-46.0

a._ H:28.0  yf28.4
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To create the mouth poses, perform steps similar to when creating the eyes, except this time work inside of the mouth symbol and not the eyes.
First dig deep into the mouth symbol. Once inside the mouth symbol add a new blank keyframe (F7) and begin drawing the new mouth pose.

& J T e ey, While drawing new mouth pose, use the onion skin feature so the previous
mouth drawing is visible to make it nicely animate with the original mouth pose.

.

Malrker

Y
Blank Keyframe (F7)
Wl @ [ el Bl Gl 2 [0k [0 ]

New mouth pose &
grayed out 0.g. pose

s

|
Onion Skin

Now that there is a closed mouth for the rabbit, make an inbetween pose of the open and closed mouths. Before making an inbetween, rearrange
the poses so the mouths are in the order of closed to open. Move frame 2 to frame 1 and frame 1 to frame 3 and leave frame 2 a regular frame,
are you confused?

© ¥ Timeline

Make a blank keyframe on frame 2 and draw an inbetween.

QoL =& a4}
— P Laver 1 /i +» B

Frame 1

Franlle 2
Inbetween Pose

Let's make an "Oh" mouth. Add a blank keyframe on frame 5, leave frame 4 a
regular frame so it can be later used for an inbetween.

© w Timeline

&40

| . @ l I o | -
Layer 1 / - Just a couple more mouths to go, an Qo and a L mouth.

A Sometimes characters need more mouths than just these
\ seven, usually a mouth chart will also containa F, S, and a
\ Th mouth. Since this character's teeth get in the way, itis
\ easy to hide animation behind them, making it possible to
 w Timeline \ lipsync with just these mouth poses. If you wanna learn
how to make a full mouth chart, refer to an animation book
because you're not gonna learn from me.

Inbetween for the Ah & Oh mouth

Oo
Frame 6

L
Frame 7
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Since the rabbit has cheeks it would look more organic if they animated with the different mouth positions. Exit the mouth to the mouthcomp
symbol and add 7 frames (F5) to the timeline to correspond to the instances inside the mouth symbol. The mouth poses should play across the
timeline since the default of a symbol is set to Loop. Add a keyframe (F68) to frame 3 on the cheek layer to lock the original pose into place. On
frame 1 squash & stretch the cheeks using the transform tool making the cheeks flatter to match the closed mouth pose. Add a motion tween
between frames 1 and 3. Now frame 2 is automatically inbetweened.

=aof 3
[J muzzle + « W 0
[ teeth = ¢ [} i
~ Wmoth e - Oy
o ld. [
Yret s @ ||t [eal 5l

i v Timeline
&80 5
[J muzzle -+ W, 1
[ teeth o ¢ i 0
[ mouth s « Wiy 0
P cheeks [ 1]

Motion Tween
Add a keyframe to frame 6 and squash & stretch the cheeks using the transform tool to match the extreme oo mouth. Insert a motion tween
between frames 3 and 6.

i w Timeline
=ag
[/ muzzle « » Wi, 0
Dl’ﬁﬂ'l « « [|ls 0
]

i Timeline

&890:1 s _ . e
L L Add a blank keyframe to frame 7, since the pose is very similar to the
E’ muzzle -+ N . | original Ah mouth, copy the cheeks from frame 3 and paste them onto
[/ teeth « ¢« i, i frame 7. Using the transform tool, very slightly squash and stretch them
just to change them a tiny bit.
[J mouth « ¢« Ol 0 J 3 .
1

i ¥ Timeline
&40 j
) muzzle « + [0
[ teeth R ]
[/ mouth « + [0
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Now that we have an animation-ready model completely constructed in Flash, we
can finally begin animation. First add frames (F5) to your mainstage timeline to set
the scene length. Usually a scene's length is determined by the dialogue track,
since we are not using a dialogue track at the moment, we are going to add as g
many frames that we want. I'm going to start with 24 frames, which is 1 second in
civilian talk.

Edit in place or click inside of the character comp symbaol, then add 24 frames to the
timeline.

A rabbit

ajaj(3alalal{aalala9] 23]

Perform the same steps inside the head comp symbol.

The eyes and mouths must be going haywire because they keep cycling on a loop. Stop the looping by clicking on the eye and mouth symbols
and then in the properties panel where it says "Loop" click and select "Single Frame." Everything should be cool now inside the head comp.

Single Frame




Key Poses 41

With the scene length set, it's time to begin keyframing or blocking out the main poses. All of the keyframed poses are to be made inside of the
character comp. I'm going to make a new start pose for the character, it will help demonstrate the concepts of creating new poses in Flash as well
as the concepts of snappy timing from pose to pose. First, it would be wise to keep the final pose which is the one that we have already created.
On frame 5 click and drag to select all of the layers starting at the top down to the bottorn of the timeline. Insert keyframes (F6). Now it is safe to

make a new pose on frame 1 without affecti‘ng the final ppse on frame 5. . & |
On frame 1, reposition the character, I'm going to draw his arms so they are straight | o
down, and also straighten out the body. The way | make new artwork is by using the | — - e
original symbol so the size remains at 100%, all of the lineweights are at a constant =40 ORI SN . DR
stroke and the edit point is on the same axis. Other people might draw new poses L armR + + B 0
differently, by "differently," | mean they do it wrong. Right-cl ick the front arm and [ handr + ¢ [,
select "Duplicate Symbol." Rename the symbol to "armR-002." Inside of the armR- [/ headcomp M | 0
002 symbol, move the original artwork away from the character so it is still available L/ badycomp 2 © (mjj 0
to grab the stroke sizes with the eyedropper (1) if needed. Draw the new arm pose, (2 neck s o H| 0
make sure that it is drawn with the shoulder jointed in the same area as the original. L/ upperlegh ++ B 1 0
Delete the original artwork once finished with the new pose. Exit the arm-002 symbol L/ lowerlegR c++ N 0
to the character comp, notice something? The edit point is already set in place over L footR + Oy 0
the shoulder, where it should be. Move the hand to its new position at the bottom of L tai + - n | 0
the new arm. L upperleglt L im| | O
Diowereg. _ » » @ q
Symbol name: |armp.-:102 [LI [ footl « o« ]
(D armL - - B
I I |
P handl ol
Original artwork \/
moved over. New arm pose
Copy .
Paste &-- ~ ~
Select All Edit point
Deselect All on the
Free Tramsfom same axis
Amrange L4
Break Apart
Diistribute to Layers
E dit
E dit in Place
Edit in Mew ‘Window
Swap Syrmbal... / ...: —

Druplic bal....
Convert to Symbal ..

Timeline Effects

Duplicate the bodycomp symbol and rename it to "bodycomp-002." Inside of the bodycomp-002 symbol, Duplicate the body symbol and rename it
"body-002." Inside of body-002, | am going to perform the same steps that | made on the arm. Once completing the new body pose, exit the
body-002 symbol into the bodycomp-002 symbol. Good thing | left the collar and ruffles separate, now | can scale, rotate and skew these symbols
using the transform tool (Q) to make them fit onto the new body pose, it sure beats drawing new ones!

scaled, rotated and skewed to make fit

In Flash, if you select 2 symbaols with
the Transform selected you can
temporarily change the edit point for
both symbols, making it more

convenient for rotating and

New body pose squashing & stretching.
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Now that | have the new drawings | need, I'm going to block out the character's first pose by moving and rotating the symbols around. Also, the
back arm should be straight down, | am going to copy the new front arm pose, paste it on the back arm layer and flip it horizontally
(Modify>Transform>Flip Horizontal). | am going to do the same with the rabbit's front hand.

Rotated
Head & Neck

_ - Same as
- front arm

Same as
- /front hand

Original Pose New Pose
{Final Pose) (Start Pose)

My objective now is to get the character from the start pose to the final pose, so pose 2 should be an Antic. An antic or anticipation is used to get
from one pose to another. You do not have to antic an action every time, especially if the movement is subtle. However if the movement is a
broad action, an antic should be executed. An antic always moves in the opposite direction of the following action, since the character will be
throwing his arms up into a boxing pose, we need to bend its body down and raise its arms into a bent position; | know we just straightened the
arms and body, but it will be fun drawing new bent poses, trust me. Before making the antic, on frame 9 click and drag to select all of the layers
starting at the top. Insert keyframes (F6), so our final pose is held in place while we create the antic on frame 5. First, to create a bent body we
are going to use the cool art brushes in Adobe lllustrator. Right-click and duplicate the bodycomp-002 symbol and rename it to "bodycomp-003."
Inside the bodycomp-003 symbol, right-click and duplicate the body-002 symbol, rename it "body-003." Select the artwork, copy and paste it
directly into lllustrator. In lllustrator, make sure the settings are properly set. Go to File=Document Color Mode=RGB. This is so none of the
colors will be adjusted between the two programs. Now go to File>Preferences>File Handling & Clipboard, make sure that under Clipboard on
Quit the settings are on Copy as PDF, AICB, and Preserve Paths, otherwise when artwork is copied back into Flash it will look like it has low
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Open the brush library in lllustrator, Window=Brushes. Select the body artwork and click the little arrow button in the upper right-hand cormer of
the Brush palette, select "New Brush." A window will pop up asking what kind of brush to make, select "New Art Brush" and click OK. The body is

now a brush.
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Using the pen tool, create a curved line about the same size as the body. Now select the line and click on the body brush. You, my friend, now
have a bent body pose. If the body appears to be fat, check the stroke size and make sure it is set on 1pt. If it still appears to be too fat, double-
click on the brush in the library to open its properties, make sure that Proportional is checked off, this should do the trick, if it didn't, better luck next

time. Also if the body is upsidedown use the Direction buttons to set it upright.

Art Brush Options

Mame: |Sad=lgl
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I~ Preview

Direction ——————
E=EER
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I FlipAlong %
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— Colorization
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Key Color: _# |:|

Tips I

]

Copy and paste the new body pose into flash inside of the body-003 symbol.

New bent body

The artwork from lllustrator is imported as Groups, select all of the groups and

Break (Ctrl+B) them (because groups are bad news). Make sure the new

pose is registered to the symbol's original position. Exit the body-003 symbol
to the bodycomp-003 symbol, use the Transform Tool (Q) to fit the collar and
ruffles symbaols to the new pose.



More Blocking 44

Create new bent arm poses for the antic by copying and pasting the armR symbol from the final pose and paste it on the front arm layer on frame
5. Rotate the arm about 180 degrees. Right-click and Duplicate the armR symbaol, rename it "armR-003." Inside of armR-003, let's get rid of that
pesky shoulder. Draw a line through the artwork to make the separation, select the half we don't want anymore, now delete it. Now we have all of
the artwork we need to create the antic for pose 2. Block out the character's second pose by moving and rotating the symbols around. Like the
first pose, copy and paste the new front arm pose to the back arm layer.

Head

Ko % JMatakefankard Do you wanna know a secret trick that | discovered, | will

only tell you if you read this: The Group Trick- To keep the
foot planted while squashing and stretching can be difficult
since the edit point is located at the ankle. While squashing
it may only allow you to squash from bottom up but not top

Tail down. The only way to get it to squash correctly without
Rotate out | having to reposition the foot, the edit point must be moved
1 to the bottom of the symbol. However, if the edit point's
Thighs i position is changed across the timeline it can create
Rotate up \ disaster when motion tweens are used. My trick around it is
| p ; i
- : by Grouping (Ctrl+G) the symbol, changing the edit point

to where you need it, making the transformation, and then
breaking (Ctrl+B) the group. Grouping a symbol preserves
its edit point, the group has its own edit point to adjust so
you can transform a symbol and have full control of the axis
you are transforming to.

)

! %

Lower everything
except feet

£--" Feet stay planted -
Squash in and Stretch out

Caution: Groups are very troublesome misfits in Flash land, you do not want to use groups for any animation purposes, they are only good for
changing temporary edit points and then breaking immediately afterwards. Utilizing groups in any other way will turn a normal scene into a
nightmare. Groups may look like symbols, but they are not, they are wannabes. Since they are trouble, they are not allowed in the library, hence
every group is a nameless loner out on the timeline. Nowhere along a timeline will you find the same group. They do not work like symbols,
where if you change the artwork in a symbal, it will change all across the timeline. Groups don't work that way, they are always interpreted as
different art even if they look the same. They also do not tween well, they might at first, but once clicking
inside a group after setting a motion tween, the movement end up wonky. Did | mention that they will
bog down a scene's playback? Groups are trouble, you've been warned!

For Pose 3, create an Overshoot. An overshoot is when the pose goes beyond
the final pose only to settle into it afterwards. | don't know a better way to explain
it, but | can say they make actions look great! Before making the overshoot, on
frame 13 click and drag to select all of the layers starting at the top. Insert
keyframes (F6), so our final pose is in for the settle. To make the overshoot, work
off of the final pose. Simply raise the rabbit up past the final pose, keeping its
feet planted, by repositioning the symbols using the Transform Tool (Q). Luckily
we do not need any new drawings for the overshoot. Notice, | rotated his arms
down, this is because the force of everything moving up is pushing the arms
down creating a drag. | tend to make my overshoots subtle, if they are too Raise everything h
exaggerated in Flash, the animation can have a "Flashy" result. except feet

Tail
Rotate in

Thighs  /
Rotate downy, 4

24
/

Now we are done with blocking out our animation. The final (original) pose, the

1
Calves
settle should already be in place on frame 13. A

(\\ Rotate in

Feet stay planted



Main Poses a5

Start Pose Antic Overshoot Settle

Tweens (again)

In earlier chapters | have already discussed setting motion tweens, here's our chance to finally use them. Select all of the frames inbetween the
keyframes, go to the properties panel, where it says "None" select "Motion." Make sure that the Scale box is checked and Rotate is set to "Auto”
and Orient to Path, Sync, and Snap are unchecked. Now the keyposes will be automatically inbetweened. However, some of the symbols may
flip, and the timing is very even and stiff, we will later have to go in and make some adjustments to get this animation to look awesome.
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To make timing less even, Flash has the ability to apply eases to the tweens. Easing is a term used in traditional animation as well as in Flash.
There are two types of easing, Ease In and Ease Out. However, the traditional and Flash eases are reversed; in traditional terms a Flash ease in
is referred to an ease out or slow out which means more inbetween poses are closer to the start position, and a Flash ease out is referred to an
ease in or slow in which means more inbetween poses are closer to the end position. Though it can get confusing trying to explain eases when
their names are the opposite between both mediums, | will only use eases in Flash terminology since this is a Flash course.

In Flash Terms

Ease In Ease Out
23
(TTN T I R | | | L
mrrer 1Tl | | | | I | | | IIIIIII|
2345 6 7 8 8 10 i 12 14 15 18 17 48 18 20 2122 24
1 (The Numbers are the frames} 13 {The Numbers are the frames)
Pose 1 Pose 2 Pose 3
Between Pose 1 and Pose 2 of the character, set ®50 5 =
the tweens on ease out. Since the rabbit is antic- L armr o+ W]
ing before an overshoot, the rabbit should start off [ handr L 0 Setting an ease on 100 usually
quickly lowering and then slow down at the end __fo} headcomp | o
. . . b - = 1
into pose 2 so ‘ther_e will be more of an impact -5 n:::m — E 0 100 may be too much, if so, set
when the rabbit animates into the overshoot pose ] — I the ease on 50. | rarely use any
afterwards. To set the tween on ease out, select upperlegh. O 0 numbers inbetween
) [ lowerlegr « - D o '
all of the layers between pose 1 and 2, then in the
properties panel where it says "Ease" the number U footR s 0 {
in the box should be set on "0" (that means there Ut oD O | Tween: |Mation | x| ¥ scale
isn't an ease applied), click and drag on the little ———D; upperiegl » ¢ O 0 e =~
: . [ loweriegl =T Ease: [100 i {10ut!
arrow next to the number box up until you reach == L 0 = ==
100. It should now say "Out" next to the little L foott O O | potate: IAutn 1 i
ik I orienttopath || Sync ™ snap

Since the arm and body symbols are different between pose 1 and 2, they are not going to tween perfectly, in fact it looks bad. So what to do to
get around this mess is to pop the symbols in pose 1 to the symbaols in pose 2 without any tweens inbetween the two. Since the tween is set on
an Ease Out, the gate between the first and second frame is very wide, this is where we can pop the pose. On frame 2, insert keyframes on the
arm layers, hand layers, body layer, head and neck layers. Copy over the keyframes on frame 5 to those on frame 2 and reposition the symbols
so the image is a nice one; make sure you re-set the ease on the tweens, they are probably back on '0". Now this tween should look beautiful.
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The time between the antic and the overshoot should be snappy, make the tween between frames 5 and 9 an Ease In at -100. Ease In's work
best when transitioning from one pose to a completely different pose, it helps hide the switch between two different drawings. There is still too
much time between these two frames, select all of the keyframes on frames 9 to 13 and drag them over to frame 7, so there is only one frame of
tweenage. The symbols flip and move really bad during this tween due it trying to inbetween different symbols, so there's some more fixing to do.
- | E re 1 rabhit

i * Timeline
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Frame 9 moved to frame 7
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Add keyframes to the arm, hand, head and neck layers. Reposition the symbols to better inbetween the two poses. Flip the front arm and rotate it
so the arm appears bending backwards. This will make the arm look like rubber hose animation which we do not see a lot of in Flash animation.
Smear the front hand by squashing & stretching the symbol, this will help the inbetween make a smoother transition from two poses that have a
broad action without having to add more time.

Head & Neck From the overshoot to the settle, the action should start
off fast to a slow stop. So add an Ease Qut at 100 to the
tween between frames 7 and 11. The inbetween looks
too stiff and flashy, let's go through and cherry this
animation out.

Front Arm
Flip and Rotate

Front Hand
Squash & Stretch
to Smear ~—==—<__

,
e Back Arm & Hand

Rotate down

Not a good transition

On frame 8, add a keyframe on the front arm & hand layers. On
frame 7 copy and paste the armR-002 symbol to help the motion by
giving the two arms, bending in opposite directions, an inbetween
using a straight arm. Make sure the ease is still set at 100. Now
the arm should have a nice ease into the settle.
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Fixing Tweens

On the head and neck layers make a keyframe on frame 9, on frame 7 rotate the head forward so it will drag from the rest of the animation. On
frame 9, raise the head and neck up, now it should settle downward. The tweens between frames 7 and 9 should be set on 0 to prevent slowing
down or speeding up. On frame 12 on the head layer, add a keyframe (F6) and remove the keyframe (Shift+F6) on frame 11, to extend the

animation of the head settling, so it is offset by a frame.

Head & Neck

Rotate forward
TR
rs

i

/

Frame 9

Frame 7

Back Hand
Squash & Stretch

Back Arm & Hand
Rotate up

Frame 9

Frame 7
Insert a keyframe on frame 9 on the tail layer. On
frame 7, squash & stretch the tail symbol making it Tail A
short and fat. On frame 9, squash & stretch the tail so Squashing Y |
it is long and skinny. This will make the tail appear to !
. : E-- Body
be reacting to the forces of gravity. On frame 7, the Rising

body is moving up putting force on the tail to flatten,
and on frame 9 the body is settling down making the
tail stretch up dragging behind the body action. On
frame 12 on the tail layer, add a keyframe (F6) and
remove the keyframe (Shift+F6) on frame 11, to
extend the animation of the tail settling, so catches up
to the body a frame late. Ease Out at 100% between
frames 9 and 12 and remove the ease between
frames 7 and 9, soitis at 0. | hope you were able to
follow all this! Trust me, it's easier to show than to tell.

Frame 7

I
' L
g Head & Neck

i w Timeline
CQDIS ..... S (R e
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This is what the head and
neck layers should look like

On the back arm and hand layers make a keyframe on
layer 9. Overshoot the arm and hand by rotating the
symbols up past the position of the final pose. For a
cartoony effect, squash & Stretch the hand a bit. Ease
In at -100% between frames 7 and 9 to give it that
extra punch. On frame 12 on the arm and hand layer,
add a keyframe (F6) and remove the keyframe
(Shift+F6) on frame 11, to extend the animation of the
arm and hand settling, so they are offset by a frame.
Ease Out at 100% between frames 9 and 12.

it w Timeline

[ armL
LA .. -
On frames 7 and 8 flip the back arm so it looks like the
arm is bending backwards due to the force being
applied to it as it moves up. When the arm reaches its
highest pose on frame 9, have it bend forward to give
the same effect as it settles rotating downward.

S| = 1

Back Arm & Hand
Rotate down

Back Hand
Squash & Stretch
to Smear

A

| Back Arm & Hand

s Rotate up
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Tail
Stretching

-

Body
Low?ring

1
v
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>

| bet you didn't think animating in Flash would be this
much work, WELL IT IS, THAT'S WHY IT'S CALLED
"WORK!" There isn't an Animate Button, the rumors
going around town are wrong. Tweens give a general
idea of how something should move, but most of the
time they need some tweaking. Sorry to kill the
fantasy, guys.
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Now that we are finished inbetweening the keyposes, the animation is still a bit stiff. If we go inside of the headcomp symbol, we can add some
overlapping ear animation that will really bring this character to life. Inside the headcomp, there should be the same amount of frames on the
timeline as on the timeline in the character comp, 24 frames. On frame 5, in the character comp, the rabbit antics down, forcing the ears back.
Add keyframes to the ear layers on frame 5 and rotate them back. Insert a motion tween between frames 1 and 5, Ease Out at 100%.

== g [A rabbit A headcomp

Ears ¢ ¥ Timeline
Rotae Back CETIRGICREE .
[J earr = s Wi, —
BN

During the overshoot on frame 7, the head is traveling backwards forcing the ears
to move forward in the opposite direction. Add keyframes to the ear layers on
frame 7 and rotate them back. Insert a motion tween between frames 5 and 7,
Ease In at -100%.

27T

=] | e1 [ rabbit B headcomp

Ears
Rotate Forward

For the settle on frame 12, the ears should return to their rest pose. To give them a little bounce, | am going to give them a tiny overshoot past the
final pose, and then settle on frame 15. Add keyframes to the ear layers on frame 12 and rotate them back. Now add a keyframes on frame 15
and position them to the rest pose (frame 1). Insert a motion tween between frames 7 and 15, Ease Out at 100%.

Exit the headcomp symbol to the character comp. Due to all of the moving

Ears .
Ears Rotate Forward to amur.1d of keyframtlas or.1 the head layer, the instances m.ay be scrambled
Rotate Back Final Pose causing the ear animation to not work properly. To fix this, on the first frame of

the head layer, select the headcomp symbol, in the instance panel make sure
that the headcomp is set on "Loop" or "Play Once" and the "First" box is set on
"1." Select all of the frames on the head layer, in the properties panel, set a
motion tween, click "Sync" on and then off. Now all of the instance numbers
should correspond with the frames they fall on. The Sync function makes sure
that all of the symbols across the layer are in sync with the symbol on the very
first frame. This may sound great, however, it only allows you to have the same
exact symbol on the one layer. For example, if | changed the motion tweens on
the arm layer to Sync, all of the different arm symbols on that layer would be
swapped out with whichever arm symbol is on the first frame. Therefore, |
would lose all of my animation, and that would be bad. That is why | turn it off

\ right after using it. By right-clicking on the timeline, there is a Create Motion
Frame 12 Frame 15 Tween function, except it is no good because the Sync is already on as a
default . To make your life easier, use the Tween in the Properties panel.
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W headcomp  f »

Notice there are no longer any lines between the
keyframes and frames, this is how to identify a
motion tween set on Sync.

Tween: IMotion 'l ¥ Scale
Ease: I j A
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I orienttopath B Sync [ Snap
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Final Animation




Chapter 6
Facial Acting
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Eye Acting

After completing the animation, you might want to add a little more zing to your character; if you are lazy, you might not! By adding some eye
blinks and what not, your character animation will look a lot cooler in just minutes! Seriously adding blinks and change of expression should really
take no longer than 5-10 minutes. To get started, first find a good place to stick an eye blink. While searching for that dream spot, keep in mind
that eye blinks work really well when a character looks in another direction, turns its head, or when a character antics. Did | just say "Antic"? The
character antics! That is where | will animate the blink.

Frame 5 is where the rabbit hits the lowest point in his antic pose, therefore, frame 5 shall be the instant the rabbit blinks. To make our character
blink, double-click your way into the headcomp symbol. Inside of the headcomp, on frame 5 insert keyframes (F6) on both eye layers.

i v Timeline nel A rabbit A headcomp
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Insert the blink by selecting both eye symbols on the mainstage using the Black Arrow Tool (V) while holding down the Shift key. In the Properties
Panel under where it says "Instance of:," type the number 6 in the "First" box or Instance Box. If we reference back to Lecture 4, the closed eye
pose is on frame 6 inside of the eyecomps, that is why | input 6 in the Instance Box. Your character should now have its eyes closed. Good job!

Instance

Instance of:

-~ Box With the final pose of the blink set, we can add inbetween blink poses on the
e [singe Frame =] Frsts s~ previous frames. Frame 2 is the first frame of the character going into the
Eyes are antic pose, so on frame 2 insert keyframes (F6) on both eye layers. With the

closed

eye symbols selected in the Properties panel, input the number 3 in the

Instance Box, make sure that the eye symbol is set on "Single Frame". |
skipped the second eye pose to the third because there is not enough time to
have all of the eye poses I've created to be in this antic. | figure | will make
the eyelids Ease Out (Flash Term) to the blink pose, using instant 3 opposed
to 2, to create a wider gate between frames 1 and 2.
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Keyframes on frame 2
on the Eye layers

On frame 3, insert some more keyframes (F6), input 4 into the Instance
Box. And to finish it off, insert keyframes on frame 4, and input 5 into the
Instance Box.
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s IISingIe Frame 'I First: |5

Instance of:

SUHE | ISingIe Frame 'l First: I 4
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With the blink out of the way, time to open this character's eyes. The head is at its highest pose
during the overshoot out from the antic on frame 9. This is where the character's eyes should
open. This time we will not add any inbetweens for the eyes to open. By popping the eyes open it
creates more of a reaction, like BOOYAH! Do the same as before, on frame 9, insert keyframes
(F8) on the eye layers, input 1 into the Instance Box. Now the eyes animate, go ahead and give
yourself a pat on the back. How long did that take, 5 minutes? Told ya!

= | A rabbic  FA headcomp Instance of: -

% v Timeline S | [smgle Frame =] Frst: [ 1
@01 s [b s = =
DEYER * * [ eaelele 0O 0§
[ pupir + o Wi, o
(1) ever white o « Wi, ol
-_.....
e @ |[4] alc] Bl s (2000 03

Overshoot on Frame 9,
" Pop eyes open
Lipsync

To make use of the mouth chart we created, let's make this character talk. First thing's first, we must have a dialogue track, otherwise we will not
have anything to lipsync to. How you get your dialogue track is your problem, | can't teach you everything! Once obtaining an audio track, be ita
.wav, .aiff, or .mp3, import it into Flash. File>Import>Import To Stage or Ctrl+R. Now that we've imported it, where is it? I'll tell you, but first you
have to create a new layer on the Mainstage timeline. Rename that layer to "Audio." Click anywhere on this layer, in the Properties Panel, a
Sound feature will appear. Where it says "Sound:"” click the box and select the file that you have just imported. Be sure to have the Sync set on
"Stream,” which will allow you to Scrub or play sound while scrolling over the track. When set on "Event”, once pressing play, the sound will start

and will keep going even after the scene ends, it can be annoying. Event is also mainly used for the web, not television. In the Audio layer you
can see what the sound looks like.

|§Scenel
i w Timeline
404 5w = = =
P rudio £+ - ﬂ i
[ Rabbit « + @O o
2 art XED O

Create Layer For Audio

Sound:  |None Sound: Iaudio.wav | | 2 Scene t
Effect: [iione B Effect: [ore ~] et | R — 4
\ == =
| L] «
. 1 \ i St *||r k M IE
Syncs |Event 3 |Repeat 3' i Eyn:._l | ream jl Epeal jl
Mo sound selected, “ \ 44 kHz Mono 16 Bit 1,2 5 103.0 k8 (27 Rabbit
S

[ art X ao| o

|:::: o Sync set to Stream, not Event!



Lipsync

To give the character lipsync, we will need to be able to hear the audio track inside of the headcomp, where we will be animating the mouths. To
get the audio inside of the headcomp, click on the layer where it says "Audio," this will highlight the whole audio layer. On frame 1 of the
highlighted audio layer, Right-Click and select Copy Frames, this will copy everything on this layer.

| % Scene 1
i = Timeline
&50
P sodio £+ - N
[ Rabbit R |
[ art x IE O O

Select Audio Layer

Double-Click on the character until you are inside of the headcomp. Create a
new layer on the timeline inside of the headcomp symbol. Highlight the whole

Inzert Blank Keyframe
Clear Keyframe

Convert to Keyframes
Convert to Blank Keypframes

Right-Click>
Copy Frames

é Scene 1
& w Timeline
a0 P P
| —L i —)
[ Rabbit P Create Motion Tween
[ art x Insert Frame Il
Remave Frames

+d4i%e] i Inzert Keyframe it

Cut Frames

Copy Frames

e ETaTiEs
Clear Frames
Select All Frames

HEVESE ETamEs
SynchTenEE Sy s

new layer by clicking on the layer name, Right-Click on frame 1 and select Paste
Frames. Now the Audio Layer from the mainstage timeline is inside of the

headcomp.

A rabbit

= Scene 1

A headcomp

i w Timeline

[A rabbic A headcomp
it w Timeline
g0 5 0 5 = =
:
[ mouth s« @
'D?'l-ﬁ @ |4 ala & u” ..... = [240Fp: B

Audio Layer inside Headcomp

With the audio inside of the headcomp, we can get started lipsyncing. The audio track that | imported says "So What Can | Get Ya?!", since you

<A | i Scene 1 [ rabbit ) headcomp

i1 w Timeline

[ mouth

Create Motion Tween

Y| i

Insert Frame
Remave Frames

Right-Click>
Paste Frames

Insert Keyframe

Insert Blank Keyframe
Clear Kayframea

Corvert to Keyframes
Corvert to Blank Keyframes

Cut Frames
Copy Frames

Paste Frames

Clear Frames
Select All Frames

EVETSE FIAMES
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are reading this, you are just going to have to believe me. Like with the eyes, I'm going to set keyframes, this time on the mouth layer, and call on

instances from inside the mouthcomp. The instances | call upon, depend on the sound in the audio track and the pose of the mouth. | am going
to Scrub the audio track and decide on each frame of sound, which mouth pose best matches, and input the frame number of the pose in the
Instance box. | would love to teach you how to lipsync, but | would hate to waste paper trying to explain when books like the Preston Blaire or

Richard Williams books can explain lipsyncing way better. Instead I'll show everything | did frame by frame and attempt explain the phonetics and

instances (See next page). Well that's it, you've actually read all the way to the last line; by the time you get to the next period, you will hopefully

know how to animate in Flash or at least have a better understanding of how it works. Good luck!!!

= | A rabbit  FA headcomp
i w Timeline
cEELLE e B S
@ audia + o+ [
| @ |t &a & e [2eemes [oos

Keyframes set

on the mouth layer
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The Pringle 58

Here's a little trick that | made, yes me. | take complete credit for this one, in fact | named it The Pringle. I'm not conceited or anything, it's an
acronym for Position Registered Inside New Graphic for Layer Editing (pretty creative, eh). In Flash, it comes with a paste in place feature that
you can only use when copying elements on the stage. But what if you want to copy frames and paste the frames in place inside a new symbol, or
in other words, how do you flatten an animated sequence into a single symbol? This is where The Pringle comes in handy. Before | introduced
this trick on the website www.coldhardflash.com, the common animator would copy the frames by Right-Clicking on the timeline and selecting
Copy Frames or Cut Frames and then in the menu selecting Insert>New Symbol. A new symbol window would open, this is where they would
paste the frames on the timeline by Right-Clicking and selecting Paste Frames. Everything at this point seems all good, except when exiting the
new symbol, it will take you out to the mainstage with no new symbol in sight. The new symbol is in the Library, making the common animator
have to drag the new symbol out on to the stage and attempt to register it to the animation it was copied from. Most of the time the registration
would take a while and not even be perfectly registered. The Pringle makes it possible to instantly copy and paste frames into a new symbol
while reqgistering them to the exact location they were copied from, like magic. This trick is great for making animated cycles into comps. The first
step is to select the keyframes of an animated sequence and then copying the frames by Right-Clicking and selecting Copy Frames.

A rabibit
- — i Timeline
i * Timeline — ———————————————
®480 ®EOp s 0 820
D armr « « W, 7 armR * | gleslalalele e
[ handr « o 0
[ handr « +« [0 an L [o o
Dheadmm « +« [ O/ éle e L
7 I
u Create Motion Tween

Inzert Frame
Remove Frames

Inzert Keyframe:

Insert Elank Keyframe

Clear Keyframe

Convert to Keyframes
Convert to Blank EKeyframes

P arml Cut Frames
B handl Copy Frames
Hing) i Paste Frames
Clear Frames
Make a new layer above the topmost layer you've copied from and draw a line using the Line Tool (N). Select Al Frames
Symbolize the line (F8). Itis very important that the Registration in the symbol menu is set on the middle o
square, or else this trick will not work. Synchionize Symbols
EA rabbic Convert to Symbol X
i w Timeline
— Name: | The Pringle oK I
=40 ] ; ! o
[ armr. . « B 7 Behavior! :: :;t\;i:nclip Registration: §E§ Cancel |
[ handr °© o W 0 % Graphic :
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New Layer - ——---— B Laver 16 O I
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Now center the line symbaol to the stage by using the horizontal and vertical
buttons in the Align Panel. This will set up the decoy to trick Flash.

i w Align =
Align:' - e
Bl& S Tl R .
Distribuite’] '::' stage Line Centered
=8'= bkhweoad ! to Stage
Match slze:"lI 52&: BiE i
=1} i! £ db \
¥ T
‘\ r-‘ \\
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Click These Make sure this is selected
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Double-Click inside of the line symbol, Right-Click on the keyframe inside and select Paste Frames. Tah-Dah!l! If done correctly, the animated
sequence should be pasted in place inside of the new symbol. Now exit the new symbol and delete all of the copied layers, they will no longer be
needed. There you go, The Pringle or Flatten Sequence Trick.
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Squashing and stretching symbols can sometimes be a little difficult depending on how the artwork is rotated when symbolized. Take this hand for
example. If | wanted to stretch it up and squash it in, because the bounding box isn't straight up and down, | would have to skew it to get better
results.

A little trick | often do to get around this is to Group (ctrl+G) the
symbol. | know, on pg. 44, | mentioned that Groups are really bad to
use, but what | didn't say was they're not bad if you are only using
them as a tool. By Grouping the symbal, it places the asset within a
new bounding box that is straight up and down and much easier to
transform. Also by Grouping the symbol, also explained on pg. 44, |
am also able to adjust the edit point to anchor the artwork on a
different pivot without affecting the symbaol's edit point inside.

Usually when trying to perform this trick on a comp symbol, the edit
point cannot be adjusted. This is because the symbol needs to be set
on Single Frame in the instance properties panel before grouping.

-
[ ] ] [ [ ] [ ] tll
; .
[ ] [ ] . . Adjusted [
_ Edit Point '
_ ¥ -~ on Group .
L] | ] n | | L ] ] §
Grouped Symbol Perfect Vertical Stretch
=
L} - | ]
.& - Now for the most important step in the process, Break
L - a (ctrl+B) the Group to release the transformed symbol.
Notice the symbol's edit point is still intact where it was last
placed.
i ] - =

Perfect Horizontal Squash

Symbol edit point— — —

Broken Group
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Adding a taper to a Flash line can be a long tedious process. It consists of converting the lines to fills and manually pulling points to get rid of
those nasty rounded ends. There are several methods of speeding up the process, here is one of them:

Here, the hand is
still all line art, look
at those rounded
ends, ewwwww!!!

Select the lines and then go to As you can see below, the line art is now a fill. Sometimes

Modify>Shape>Convert Lines To Fills the converting lines to fills can drop out lines and can be
quite frustrating. Don't
punch your computer yet!
Check out the next page and
read how to avoid that "Flash

goodness."
Modify
Document... Ctile)
Convert to Symbol... F8
Bieale fnart (ShirE
Bitmap »
Symbal »
Smooth
{ Timeline f e
} . . »
Timeline E ffects < Optimize. .. Ci+Alt+Shife+C
Transform
Amange
Align
| fd i CHI-GHif
Group Ciil+G Rem [ Hinks :
.I"I"'I' ._'._.l..— r il plaaddid
Now intersect Select that little In the toolbar at Options
the end of the piece of line using the very bottom of
filled line art the Selection Tool the list of icons, ﬂ
using the Line (V) click the
Tool (N) Straighten icon 1=
, N
several times |
Straighten
Options
Notice now the In the toolbar at pr——
selection has the very bottom of
straight edges. the list of icons, La b
click the Snap to
Objects, the {Snap to Objects|
magnet one. -r

Delete the intersecting line and
manually pull the points and
adjust the linework to get a taper.
It's still tedious yet more
convenient than other methods.



Converting Lines to Fills Trick
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As | mentioned before, converting lines to fills can sometimes drop out lines, here is how | work around it.

Here is the hand
when first trying to
convert lines to
fills. Notice some
of the lines have
dropped out.

Now if | try
converting lines to
fills again, | get
perfect results. (Tne
art is selected with the
white arrow, so you can
see thal it's converted. )

It might seem like this process is a little
tedious and annoying, but remember
that these three steps can be made
into a customized hotkey command by
using the History Panel (pg. 14, 15)

ii w History =

lk Change Selection
I Double Click
& Hide Layers
£ Hide Layers
Ik hange Selection
[ Change Selection
I Double Click
E Select None

i~} selection Rect

Replay Steps
Copy Steps

View »

Clear Higtary

Save As Command

To fix this, the first thing to do is undo (ctrl+z) the
faulty conversion, so we have the original line art to
work with. Now, select the artwork and in the
Transform panel, rotate the art by 1.0°. For some
reason, Flash does a better job working with points
when the art is skewed or rotated. | know, it really
doesn't make much sense. :

i w Transform
-]
1 100.0% 3 100.0% [V Constrain

& Rotate £ 100
csen T[T
2]

| R

Bl

For the last step, the art should be rotated back to its
original position. Select all of the artwork again, and
in the Transform panel, rotate the art the opposite
way, -1.0°. There you have it, a perfectly converted
line.

i

i = Transform

a8
#*[100.0% % [100.0% [ Constrain
% Rokate 4' -1.0°
Cskew & L w 1
| 0

Keyboard Shortcuts

Cammand name: | carvertlinestofils

Current Ipringlework j =6 O
Commands: IDrawing Menu Commands ﬂ
=l Commands d
#Manage Saved Commands. ..
et More Commands. ..
“Run Command. .. J
~align center Chrl+shift+C
~break loop Chrl+Shift+5
o 1 ofills Chrl+*
Keyframe Remove Tween Chr+F6
“Layer Frame Distributer
Description:  -—-
Shorbouts: 4 | —
Chrl+ =
E3 Press key: |th’|+‘ Change |
oK I
Caneel

Now this little trick is only a click
of a button.
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A much faster way of applying a taper (or any texture for that matter) to a line without having to manually pull points is to use Adobe lllustrator.
This is a method used on several Flash television productions, including Foster's Home For Imaginary Friends, which uses a rough pencil line on
all of it's character designs. The steps are exactly like those performed on pg. 43, when we bent the body using an lllustrator brush.

| tend to perform these steps after the artwork i
is symbolized to prevent the stage becoming
a huge mess. First, inside the hand symbol,
select all of the linetool art. Copy it (ctrl+c).

Now Paste (ctrl+v) the
linetool art into the lllustrator
application. Notice the ends
of the line are already
squared off, we are already
one step closer to getting rid
of those rounded Flash line
ends, YAY!

With the line art [ Brushes ™ =

selected, in the brush =
. ’ e | - =
palette, select any a0 |
brush your heart D 0
desires.
o () -
/ | -
30 20
e —
R
X 7= & 9 7

If | were to apply a rough pencil
brush texture like the one used
in Foster's Home for Imaginary

Friends, my character's hand

would look something like this at

first. As you can see, a lot of

clean up still needs to be done.

Using the White Arrow (A)
select a break in the line.

Broken area selected

-
p—

The line art instantly acquires
the texture style of the selected
brush. The line can now be
adjusted using the stroke
panels, changing the direction
of the brush in the Art Brush
Options (pg. 43), or manually.

First thing to do is to adjust the
stroke. In the Stroke Panel,
enter a value and press enter.

= Stroke ! ! E!

Wiaight: ED.?S pt - I ’

The lines are at a better
thickness now, however, some
of the lines have breaks in them
that need to be fixed.

Deselect the intersecting line that causes the break by holding down
Shift while clicking that pesky line with the White Arrow (A). Go to
Object>Path>Join (ctrl+j), a window pops up asking if you want a
corner or smooth, it doesn't really matter which one you pick so just hit

oK boin

Foints
f* Cormer

¢ Smooth Cancel |

The break should now be fixed.
The same steps should be
performed on the rest of the
hand where any other breakage
occurs.
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This is what the hand should look like
once all of the breaks are joined.

| Scissor Tool
There are still a couple more steps RI (C)in the
that have to be performed to complete h

Select the

: : toolbar.
this clean up process. The line around
the thumb gets really thin, to make it L | Scissors Tool (C) I
thicker, add a break in the line around -
the wrist area. Click the line at the wrist to break

the line. Now the line has gotten a
little thicker around the thumb, but
it's not thick enough.

In the brush palette, it is good to have _E% Select the line using the White Arrow
Brushes ™,

doubles of all of your favorite brushes. = (A) and select the brush directed the
Each duplicate should be flipped in the = opposite way to flip the weight of the
opposite direction (pg. 43). This will taper. Now we are done cleaning the
allow you to easily change the ¥ 7= 5 3 2 hand with the pencil texture. Select

thickness of tapers at specific ends. the line art with the Black Arrow (V)
and Copy it (ctrl+c).

Remember to change the clipboard preferences in
Illustrator before copying and pasting artwork back into
Flash (pg. 43). File>Preferences>File Handling &
Clipboard, make sure that under Clipboard on Quit the

settings are on Copy as PDF, AICB, and Preserve Paths. Facs L Tinsh: 0! e hand

symbol, make a new layer above the

artwork, paste in the cleaned up line

; mlm;“:: | = art, and register it to the artwork on the

| I Enctle ersion Cue Tenvemve | I I e | layer below. The cleaned up lines

| ¥ Use LowResolution Proxy for Linked £P5 : paste in as groups, you should

Update Lirks:  [Ask wheniodiied x] LTI probably Break them.
et | -

-~ Chpboard on Quit T &80 i

| Copyas: ¥ POF 1

| ¥ A58 {no Iransparency suppart)

 Praserve Pains D E2yerd] * 0
1 Praserve Appearance and Cverprints
) Exit the hand symbol and check it out, Pencil line

Select the original Flash line art, Cut it &5 0 ﬂ . textured clean up. How about that!
(ctrl+x), make a new layer between the [ Layer 2 « o @
two existing layers and Paste in Place 3 u
(ctrl+shift+v) the Flash line. Now right- L Layer 1 -
click on the layer icon and select P

. . . . iy
Guide. This will turn the Flash line art GF ook Others i
layer into a guide layer, which allows Hide Others
artwork to exist on a layer but will not T
be visible outside of that symbal or T Delete Layer B
when the file is rendered. | do this to
be safe. If | ever need to make Add Motion Guide I
adjustments, | will still have my Flash — —
line art as back-up. Again, | do these mang
steps after the artwork is symbolized to L) Layer 2 - - 0
keep my file clean, every asset should T —

have three layers inside of its symbol
when cleaned up using Adobe
lllustrator.



lllustrator Textured Sequence

Applying an lllustrator texture to a sequence, like a mouth chart or an eye chart can take a while. Working with multiple images, copying and
pasting back and forth between Flash and lllustrator, and making sure everything is registered is extremely time consuming. Here is a way to
speed up that process using most of the tricks previously noted.

Here is our character's mouth
chart. Every mouth is on a
keyframe. The first thing to do is
to put each keyframe on its own
layer. To do this, cut (ctrl+x) the
mouth, Insert a new layer, and
paste in place (ctri+shift+v).

I Laver 1

Using the Layer Frame Layer to Frame # Frame to Layer

Distributor, a window will pop
up and ask how to sort the
frames. For Frame to Layer,

 Bottom First
Layer ko Frame

" Tap First

2

JIRRRRAR

keyframe on its own layer. The

for it on Google and install it into
your commands, it will save you |

Now the mouths are distributed to
their own layers.

pick Last Frame as Top.

Frame ko Layer

 starting Frame as Top

' Last Frame as Top

¥ Delete Frame Element

Cancel |

[Fiie
Mew... Crl+M
Open... Chil+0
Open from Site. ..
Open Recent 3
Cloge Chrl+ws
Close Al

Save Crl+5
Save and Compact
Save As..,

Save az Template...
Save Al

Hevert

Chrl+5hift+5

Irnpart 3

Export Movie...  ChivAl+Shift+S |

In lllustrator, Open the .ai file exported from Flash.

Loak it [ 53 Hew Clazs =H0r 0
o
File riamer mell‘:s el ;j Opan
Fies ol lype: [ Famanz =] Carcel i
4

Export an lllustrator (.ai) image.
File>Export>Export Image

Export Image HEI
Save i |1 How Class 0 0r O
Iy Fiecent
Diozumiants
My Comauter
-
(ST Fiie name: [umlr.x j Save I
Seveasbpe  [idobe bt [ = Cancel /I
_/J

There are commands available for | Commands
download online that will speed up
this process of putting each

Manage Saved Commands...
Get More Commands...
‘ Run Command...

65

. align center Ctil+Shift+C
one | found and use is called (| braskleep S hiftss
"Layer Frame Distributor”. Look | convertinestofills Chrl+*

. Keplrame Remove Tween  Ctl+F6

Layer Frame Jter

P y
D MewlLayer 1 v

D MNewlayer 2 E

D MewlLayer 3 L
[ NewLayer4 =
[J MewLayers  » o
D MNewlLayer 6 . .

000 EOOL]

In the Layers Panel, notice that each mouth pose is on its

own sublayer, much similar to how it was set up in Flash.

MNow with all of the mouth poses in lllutrator at once, apply the

line textures using the brushes, refer to pg. 63, 64.
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lllustrator Textured Sequence Continued... ¢

Atfter completing the lllustrator clean up, the mouths are

about ready to export. El
Layers L2 Mew Layer...

= i Layer Mews Sublayer...
Duplicate "Layer"
[Velere Selestion

] <t oups

-

=t oups

“aroupE Options for "Layer"..

=aroupE

Make Clipping Mask

-

=t oupE

LLazate et
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E <t oups

9 9|9 9 9 9 9 @
L e e e
(][] 4] Sl <,
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(o]
o
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Q

Ierge Selected
Flatten drtwork
Collect in Mew Layer

1 Layer @ Sa Al = Release ta Layers [Build)
Heyverse Wrder

Before exporting, because

Template
the sublayers alre labled as Hide Al Laers
groups, the main Iayer Outline All Layers
must be Released to Lock All Layers
Layers (Seq UEI'IDG}. Paste Remembers Layers
The sublayers should now be labled as _E% che:ﬂse th? W”tl nFOIt . I
layers. Select all of the sublayers and || Layers™ PO COHTR YA EIGST.

w4 Layer Q ;I
B Zioere 0
CEZEEN

drag them above the main layer.

The sublayers are now regular layers and m

|9 9 99 @9
1| | o {

: should import into Flash without any IRk =
TN | ot ® | B o
g o o 5| Bues o
iz sl s o
- | Layer& o
[ [ ELayer? Q
LI E |— [ ELayerS (]
1 Layer & a3 @ @ 4 L DLayer O

-
8 Layers Ly wal 4] -

Export the lllustrator file as a Macromedia Flash {.swf) file. Make sure to Export As, Al Layers to SWF Frames.

Lt = Click OK. Mactomedia® Flash™ [SWF] Farmat Options
Save it [ 13 Hew Class = e 5

- Export Cptions

Frame Rafe:

I~ Reat Cnly
™ Clin to Arthoard Size

CurveQuaity [10 »
% Preserve Appearance
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Image Cotions
Image Format: & Lossless

(™ Lossy [JPEG)

&
€ Bazeln: CptmEes

Fesoludion. |72 i

Fnu:llv: sl d Save




lllustrator Textured Sequence Continued... ¢

Import (ctrl+r) the swf file onto the new layer. Now all of
In Flash, in the mouth symbol, insert a new layer above the lllustrator textured mouths are imported inside the
the layer that contains the flash line (pg.64). mouth symbol in sequence on their own layer, but are
probably not registered.

~ Scene 1l [ rabbit A headcomp A mouthcomp B mouth

< Scene 1 [ rabbit A headcomp [ mouthcomp [ mouth

I Layer 12
[ Flash line |
L fil « « 0Ol

Flatten the lllustrator textured mouth sequence into a

symbol by using The Pringle (pg. 58, 59). This will make
it easier to register the textured line to the Flash line.

A mouth

A moutheomp

A rabbit FA headcomp

Once registered, convert the textured line layer to
keyframes (F6) and then Break (ctrl+b) the Pringle symbaol
on each keyframe since we only needed the Pringle for
registration purposes.

ene 1 [ rabbit A headcomp A mouthcomp B mouth

[ flash line
L il « » O

For the last step, right-click the flash line layer and change it to a Guide
(pg. 64) so the flash lines don't show outside of the mouth symbol.
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If you did it all right, your mouths should look something like these, and hopefully it didn't take you too long.




